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Chapter 1

MassARRAY® SARS-CoV-2 Panel
Product Information

1.1  Intended use

The MassARRAY SARS-CoV-2 Panel, for use on the MassARRAY System, is a reverse 
transcription (RT-PCR)/MALDI-TOF test intended for the qualitative detection of nucleic 
acid from SARS-CoV-2 in upper respiratory specimens (nasopharyngeal swab, 
oropharyngeal swab, nasal and mid-turbinate swabs, and nasal and nasopharyngeal 
aspirate) and bronchoalveolar lavage (BAL) collected from individuals suspected of 
COVID-19 by their healthcare provider. Testing is limited to laboratories certified under 
the Clinical Laboratory Improvement Amendments of 1988 (CLIA), 42 U.S.C. §263a, that 
meet requirements to perform high complexity tests.

Results are for the identification of SARS-CoV-2 RNA. SARS-CoV-2 RNA is generally 
detectable in upper respiratory specimens during the acute phase of infection. Positive 
results are indicative of the presence of SARS-CoV-2 RNA; clinical correlation with patient 
history and other diagnostic information is necessary to determine patient infection 
status. Positive results do not rule out bacterial infection or co-infection with other 
viruses. The agent detected may not be the definite cause of disease. Laboratories within 
the United States and its territories are required to report all results to the appropriate 
public health authorities.

Negative results do not preclude SARS-CoV-2 infection and should not be used as the 
sole basis for patient management decisions. Negative results must be combined with 
clinical observations, patient history, and epidemiological information.

The MassARRAY SARS-CoV-2 Panel is intended for use by qualified clinical laboratory 
personnel specifically instructed and trained in the techniques of reverse transcriptase-
PCR and in vitro diagnostic procedures. The MassARRAY SARS-CoV-2 Panel is only for 
use under the Food and Drug Administration’s Emergency Use Authorization.

1.2  Workflow/Test principle

After collection of upper respiratory (nasopharyngeal swab, oropharyngeal swab, nasal 
and mid-turbinate swabs, and nasal and nasopharyngeal aspirate) or bronchoalveolar 
lavage (BAL) specimens in viral transport media (VTM) or universal transport media (UTM), 
RNA extraction is performed using the ThermoFisher KingFisher Flex Purification System 
with the Omega Bio-Tek Mag-Bind Viral RNA Xpress Kit. RT-PCR with iPLEX® Pro 
chemistry then reverse transcribes and amplifies target regions of interest. After the 
inactivation of unincorporated dNTPs, a sequence-specific primer extension step is 
performed, in which a single nucleotide is added to the probe, using the supplied Extend 
primers and iPLEX Pro reagents. 

The extension products (analyte) are desalted, transferred to a SpectroCHIP® Array (a 
silicon chip with pre-spotted matrix crystal) and then loaded into the MassARRAY 
Analyzer (a MALDI-TOF mass spectrometer). The analyte/matrix co-crystals are irradiated 
by a laser, inducing their desorption and ionization. The positively charged molecules 
accelerate into a flight tube towards a detector. Separation occurs by time-of-flight, which 
is proportional to the mass of the individual molecules. After data processing, a spectrum 
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is produced with relative intensity on the y-axis and mass/charge on the x-axis. Data 
acquired by the MassARRAY Analyzer is processed by MassARRAY Typer software, and 
then the MassARRAY SARS-CoV-2 Report software.

Table 1.1   Workflow

1.3  Product description

The panel consists of 5 assays targeting the genome of SARS-CoV-2: three probe the viral 
nucleocapsid (N) gene and two probe ORF1 and ORF1ab. The panel also contains an MS2 
phage assay that monitors RNA extraction. 

Table 1.2   MassARRAY SARS-CoV-2 Panel Content

Step See...

1. Software Setup Chapter 2

• Import the assay design file.
Only required before the first time you run the panel.

• Create a virtual plate.

2. Assay Protocol

RNA extraction

RT-PCR amplification

SAP reaction

iPLEX Pro extension reaction

Water addition

3. Data Acquisition on the MassARRAY System

MassARRAY System with Chip Prep Module 96

MassARRAY System with Chip Prep Module 384

4. Generate Results Reports

Assay Name Region

SC2-N1 Nucleocapsid

SC2-N2 Nucleocapsid

SC2-N3 Nucleocapsid

SC2-ORF1 ORF1

SC2-ORF1ab ORF1ab

MS2 Phage -
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1.4  Materials provided

The following items (Table 1.3) are provided in the MassARRAY SARS-CoV-2 Panel Kit. 
Upon receipt, store the items as described. 

Table 1.3   MassARRAY SARS-CoV-2 Panel Kit Contents

The MassARRAY SARS-CoV-2 Panel Kit can be used up to ten times, as long as 
components are maintained on ice or a cold block during access and returned to storage 
conditions after use.

Table 1.4   MassARRAY SARS-CoV-2 Panel Kits

Materials Provided
Shipping 
Condition

Storage 
Temperature

Storage 
Location 

(see Table 3.1)

MassARRAY SARS-CoV-2 Panel
• MassARRAY SARS-CoV-2 Panel 

PCR Primers
• MassARRAY SARS-CoV-2 Panel 

Extend Primers
• UNG (heat labile)
• MMLV Enzyme
• RNase Inhibitor
• MS2 Control

Dry Ice -25°C to - 10°C Lab Area 2

PCR Reagent Set with dUTP
• MgCl2, 25 mM
• 10X PCR Buffer
• dUTP/dNTP Mix
• PCR Enzyme

Dry Ice -25°C to - 10°C Lab Area 2

iPLEX® Pro Reagent Set
• 3-Point Calibrant
• iPLEX Termination Mix
• iPLEX Buffer Plus, GPR
• iPLEX Pro Enzyme
• SAP Buffer
• Shrimp Alkaline Phosphatase (SAP)

Dry Ice -25°C to - 10°C Lab Area 2

SpectroCHIP CPM Arrays Ambient 
Temperature 15°C to 25°C Lab Area 3

Part # Number of tests Type of SpectroCHIP Array

13279F 960 tests SpectroCHIP CPM-96, 10 x 96

13281D 3840 tests SpectroCHIP CPM-384, 10 x 384

13278D 768 tests SpectroCHIP CPM-384, 2 x 384
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1.5  Materials required but not provided

Table 1.5   Materials Required but not Provided
Item Source/Specification

Instruments and Equipment

MassARRAY System with:
• Typer software v5.0.1 or greater
• RT-Workstation v4.1 or greater
• Chip Prep Controller v2.2 or greater

Agena Bioscience; MassARRAY System with 
Chip Prep Module (CPM) 96

or

Agena Bioscience; MassARRAY System with 
Chip Prep Module (CPM) 384

Plate centrifuge MLS; Max. RCF with plate rotor: 3,486 x g

Vortex MLS; Variable speed, suitable for tubes and 
plates

Mini tube centrifuge MLS; Recommend additional rotor option for 2 x 
8-tube PCR strips

Refrigerated tube centrifuge MLS; Capacity up to 12,000 ng

Thermocycler MLS; With appropriate plate block; max ramp rate 
4°C/second

PCR workstation with UV irradiation MLS; UV light with timer; dual UV bulb preferred

Additional Software

MassARRAY SARS-CoV-2 Report v1.4 or greater Agena’s customer support portal

RNA Extraction Materials

Mag-Bind® Viral RNA Xpress Kit Omega Bio-Tek, #M6219-2304

KingFisherTM Flex Purification System, 
KingFisher with 96 Deep-well Head

ThermoFisher, #5400630 

KingFisher 96 deep-well plate ThermoFisher, #95040450

KingFisher 96 standard plate ThermoFisher, #97002540

KingFisher 96 tip comb for deep-well magnets 
plate

ThermoFisher, #97002534

KingFisher tip comb presenting plate ThermoFisher, #267600 

Ethanol MLS; Absolute (200 proof), molecular biology 
grade

Nuclease-free water MLS; molecular biology-grade

Isopropanol, molecular biology grade Sigma Aldrich (#I9516) or equivalent

Additional Reagents

Positive SARS-CoV-2 RNA Control Twist Bioscience Synthetic SARS-CoV-2 RNA 
Control 1 (#102019)

HPLC-grade water MLS; Residue after evaporation ≤2ppm; Sterile, 
nuclease- and DEPC-free; >18.2 MΩ

DNA AWAYTM MLS

Type 1 water or deionized water MLS; NCCLS, CAP or ATSM; >18.2 MΩ

Clean Resin Agena Bioscience, #08060 [40g], #08040 [28g]
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“MLS” indicates that the item is available from major laboratory suppliers.

Labware

Electronic multichannel pipettes and filtered tips 
(Optional; can use manual multichannel pipettes)

MLS; 8- or 12-channel electronic adjustable tip 
spacing pipette; 0.5 µL -12.5 µL

Manual multichannel pipettes and filtered tips MLS; 8- or 12-channel pipette
0.5 µL - 20 µL
20 µL - 200 µL

Single channel pipettes and filtered tips MLS; 0.1 µL - 2 µL
0.5 µL - 10 µL
10 µL - 100 µL
100 µL - 1000 µL

Microtubes MLS; RNase-, DNase-, human DNA-, and PCR 
inhibitor-free

Volume: 1.5 mL, 5 mL

PCR strip tubes (optional) MLS; 8- or 12-well strips with caps; volume: 0.2 
mL

Tube racks MLS

Sealing roller tool and paddle MLS

Disposable pipetting reservoirs MLS; DNase- and RNase-free; volume: 25 mL and 
50 mL; sterile

Clear adhesive plate seals MLS; Strong adhesive, -20ºC to 120ºC

MassARRAY System with Chip Prep Module 96

96-well semi-skirted, colored microtiter plates

OR

96-well non-skirted microtiter plates

ThermoFisher MicroAmp® EnduraPlateTM 
#4483343 or equivalent.; Working vol.: 0.2 mL; 
Max well volume: 0.25 mL

Thermo ScientificTM PCR Plate #AB0600L or 
equivalent; Working volume: 0.2 mL; Max fill 
volume: 0.3 mL

Isopropanol MLS

MassARRAY System with Chip Prep Module 384

384-well microtiter plates Thermo ScientificTM 384-Well Full Skirted PCR 
Plate #TF-0384 or equivalent; Full skirted: 
Working volume: 25 µL, Max volume: 40 µL 

Isopropanol MLS

Item Source/Specification
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1.6  Samples and controls

Patient samples must be collected according to appropriate clinical guidelines. Positive 
and negative test controls must be included and examined prior to interpretation of 
patient test results. Include the following controls on each plate:

Table 1.6   Controls

*PC must be “detected” with all 5 targets in order to pass QC 
**NC must be “not detected” by all 5 targets in order to pass QC.

1.7  Symbols

Table 1.7   Symbols

Control Type Description Purpose Frequency of Testing

Positive Control*
Twist Bioscience Synthetic 
SARS-CoV-2 RNA Control 1 
#102019

Used to monitor RT-PCR 
reaction set up and reagent 

integrity.
Each run, starting at RT-PCR.

Negative Control** Nuclease-free water

Used to monitor 
contamination during RNA 

extraction and RT-PCR 
reaction.

Each run, starting at 
extraction.

Extraction Control MS2 Phage RNA Use to monitor RNA 
extraction. Every sample.

Catalog number Temperature limits

Batch code Manufacturer

Use-by date For in vitro diagnostic use

Quantity Contains sufficient for <n> 
tests
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Chapter 2

Software Setup

2.1  Import the assay design file

Note: The assay design file only needs to be imported once, prior to running the panel for 
the first time.

1. Locate the MassARRAY SARS-CoV-2 assay design file (MassARRAY SARS-CoV-
2_ADF.tsv), at C/MassARRAY/Typer/bin/Reports/MassARRAY SARS-CoV-2 Report.

2. Open MassARRAY Typer Assay Editor.

3. Create a new assay project in the Database Browser by right clicking the root node 
and selecting Project Administrator.

4. Add a new Assay Project with an appropriate name. The new Assay Project will 
appear in the database browser. The MassARRAY SARS-CoV-2 assay design file will 
be stored in this project.

5. Right-click on the newly created Assay Project and select Import Assay Group in 
Designer format...

6. Remove the checkmarks next to Design Summary and SNP Group. Make sure that 
there is a checkmark next to Assay Group.

7. Click the Browse button next to Assay Group. In the Open window, select All Files in 
the Files of type: field.

8. Navigate to the folder containing the MassARRAY SARS-CoV-2 assay design file 
(MassARRAY SARS-CoV-2_ADF.tsv), select it, and click Open.

9. Click the Import button to import the file.

2.2  Create a virtual plate

Note: Plate names and sample names should all be unique.

Create a sample group Note: Each plate contains one positive control sample and one negative control sample. 
In order for the software to recognize the controls, “PC” must be the prefix for positive 
control samples, and “NC” must be the prefix for negative control samples (e.g., PC_1, 
NC_1).

1. Create a text file (.txt) of sample descriptions in a spreadsheet application such as 
Microsoft® Excel. The file must contain the sample ID in column A, and may contain a 
description in column B.

2. Create a sample customer and sample project in the database, if you have not already 
done so.

a. Open the MassARRAY Typer Plate Editor software and click on the Sample tab.

b. To create a sample customer, right-click the root-node and select Add New 
Sample Customer. Enter a sample customer ID and additional optional 
information and click OK. The new sample customer will appear in the Sample tab.

c. To create a sample project, right-click the sample customer that the sample 
project will be under and select Add New Sample Project. Enter a sample project 
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ID and optional additional information and click OK. The new sample project will 
appear in the Sample tab.

3. Create a sample group.

a. Right-click on the sample project that you want to add the sample group to and 
select Add New Sample Group. 

b. Enter a sample group ID and click the folder button in the toolbar to browse to the 
location of your sample group text file, and click Open, then click OK.

Create a Plate 1. Create a customer and project in the database, if you have not already done so.

a. In the MassARRAY Typer Plate Editor software click on the Plate tab.

b. To create a customer, right-click the root-node and select New Customer. Enter 
a customer ID and additional optional information and click OK. The new customer 
will appear in the Plate tab.

c. To create a project, right-click the customer that the project will be under and 
select New Project. Enter a project ID and optional additional information and 
click OK. The new project will appear in the Plate tab.

2. Create a plate.

a. Right-click on the project that you want to add the plate to and select New Plate.

b. Enter a unique plate ID and select the plate type (96- or 384-well) and click OK. 
The new plate will appear in the Plate tab and a plate layout will be created 
automatically, based on the plate type specified.

Apply Assays to the 
Plate

1. In the Plate tab, select the plate that was just created. 

2. Select the Assay tab and locate the MassARRAY SARS-CoV-2 assay design file you 
imported earlier (MassARRAY SARS-CoV-2_ADF.tsv).

3. In the plate layout, select the wells of interest.

4. In the Assay tab, right-click the plex or assay that you want to assign to the selected 
wells and select Add plex or Add assay.

Apply Samples to the 
Plate

1. Click on the Sample tab.

2. In the plate layout, select the wells of interest.

3. Right-click the sample or sample group that you want to assign to the selected wells 
and select Apply Samples from Group or Add Sample.

4. Select File > Save from the toolbar.
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Chapter 3

Assay Protocol

3.1  PCR thermal cycler qualification

Prior to first use of the MassARRAY SARS-CoV-2 Panel, you must qualify the PCR thermal 
cycler by running 20 positive control reactions.

1. Prepare positive controls as per instructions in Section 3.5, Positive control 
preparation.

2. Run 20 replicate positive control reactions as per instructions in Section 3.6, RT-PCR 
amplification through Section 3.9, Water addition. Ten replicates should be from Step 
2 of Table 3.3 (1,000 copies/μL) and 10 replicates from Step 4 of Table 3.3 (50 copies/
μL).

3. Perform data acquisition as per instructions in Chapter 4 or Chapter 5 (depending on 
which MassARRAY System you are using).

4. Perform analysis of results as per instructions in Chapter 6.
Acceptance criteria: All 20 positive controls have a result of Pass, as described in 
Table 6.1.

5. Qualified PCR thermal cycler is to be labeled “For Emergency Use Only” using the 
template provided in Appendix A.

3.2  Lab areas and plate layout

The laboratory space should include three separate (non-contiguous) work areas to 
prevent contamination of PCR products. Table 3.1 shows the activities that are conducted 
in each area.

Table 3.1   Lab Area Activities

Include one positive control and one negative control on each plate.

Lab Area Activities

1 Isolation and preparation of RNA.

2
Pre-PCR preparation, including preparation of the RT-PCR cocktail, 
addition of the RT-PCR cocktail and RNA to the reaction plate, and 
preparation of the SAP and extension cocktails.

3

Positive control sample preparation. Thermocycling the reaction 
plate after addition of RT-PCR cocktail and RNA; addition of the SAP 
cocktail to the reaction plate and thermocycling; addition of the 
extension reaction cocktail to the reaction plate and thermocycling; 
desalting; nanodispensing; and data acquisition.
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3.3  Sample collection, handling, and storage

Upper respiratory (nasopharyngeal swab, oropharyngeal swab, nasal and mid-turbinate 
swabs, and nasal and nasopharyngeal aspirate) and bronchoalveolar lavage (BAL) 
specimens must be collected and stored in VTM or UTM. Samples must be collected, 
transported at stored using appropriate procedures and conditions as outlined in CDC 
guidelines (https://www.cdc.gov/coronavirus/2019-ncov/lab/guidelines-clinical-
specimens.html). Store specimens at 2-8°C for up to 72 hours after collection. If a delay in 
testing or shipping is expected, store specimens at -70°C or below.

3.4  RNA extraction

IMPORTANT!
Perform this procedure in Lab Area 1.

Preparation before 
each extraction

1. Thaw MS2 Control, carrier RNA, and samples on ice.

2. Shake the tubes containing the sample at room temperature for 30 minutes.

3. Use 200 μL as the input sample in Step 4 below.

4. Use 200 μL of nuclease-free water as the negative control sample input in Step 4 
below.

Reagent and sample 
preparation

1. Determine the number of required reactions based on the number of patient samples 
to be processed, plus one negative control per extraction set.

2. Prepare fresh lysis master mix by adding 1 μL of carrier RNA and 5 μL of MS2 to 240 
μL of TNA lysis buffer, per sample.
Lysis master mix can be made in bulk and distributed to individual samples. It is 
recommended to use a 10% overage for 96 or more samples, and 15% for less than 
96 samples.

3. Ensure Mag-Bind Particles RQ are completely resuspended in solution before adding 
to master mix by vortexing and mixing thoroughly.

a. Prepare fresh binding master mix by adding 5 μL of Mag-Bind Particles RQ to 280 
μL of 100% Isopropanol per sample. Binding master mix can be made in bulk and 
distributed to individual samples. It is recommended to use a 10% overage for 96 
or more samples, and 15% for less than 96 samples.

4. Transfer 200 μL of sample to each well of a KingFisher 96 deep-well plate.

5. Add 246 μL lysis master mix to each sample. Mix samples by pipetting up and down 
10 times.

6. Add 285 μL binding master mix to each sample. Mix samples by pipetting up and 
down 10 times.

7. Prepare other reagent plates according to Table 3.2. The plate position dictates deck 
positions of each plate on the KingFisher Flex instrument. Load plates into deck 
positions according to Table 3.2.
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Table 3.2   Plate Layout

KingFisher Flex 
operation

1. Refer to KingFisher Flex User Manual for general instructions on using the KingFisher 
Flex.

2. Turn on the KingFisher Flex.

3. Load Bindit 4.0 software.

4. Select Open and load program (Omega_M6219_50Elution_KFF.bdz) on instrument. 
Load plates onto instrument when prompted. 

• The protocol is stored on C:\Users\Public\Documents\Protocols.

• Scripts can be obtained from Omega Bio-Tek at https://
www.omegabiotek.com/.

• Commonly run scripts are also listed in Recent Protocols in the main Bindit 
screen.

5. When the instrument is ready, press Start.

a. The instrument will prompt you to save the run with a unique name.

b. The user has the option to assign sample names, as well as record reagent lot 
numbers, to the plate prior to starting the run.

c. The deck will rotate and inform the user which plate to load.

d. Make sure the plate orientation is correct by aligning the plate’s A1 well to A1 on 
the deck.

e. After placing a plate on the deck, press Start in order to place the next plate.

f. Repeat until all plates are loaded.

g. Press Start after all plates are loaded to initiate the rest of the run.

6. Discard all plastic consumables after each run by following the instructions on the 
software or control panel located on the KingFisher Flex. 

STOPPING POINT
Use RNA right away or cover the sample elution plate with an adhesive plate sealer and store at 
2-8°C until needed for PCR set-up. For longer term storage, store plate at the -80°C using a foil 
adhesive seal.

Plate 
Layout 

Position
Plate Type Content Volume (μL)

1 KingFisher 96 deep-well 
Lysate (lysis master mix, 
sample, binding master 

mix) 

731

2 KingFisher 96 deep-well RMP Wash Buffer 350 

3 KingFisher 96 deep-well 80% Ethanol 350 

4 KingFisher 96 deep-well 80% Ethanol 350 

5 KingFisher 96 standard or 
KingFisher 96 deep-well 

Nuclease-Free Water 50

6 KingFisher 96 standard or 
KingFisher 96 tip comb presenting

96 tip comb for deep-well 
magnets 

n/a

7 n/a n/a n/a

8 n/a n/a n/a
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3.5  Positive control preparation

IMPORTANT!
Prepare the positive control sample in Lab Area 3.

Prepare the positive control by diluting the Twist Bioscience Synthetic SARS-CoV-2 RNA 
Control 1 (1x106 copies/µL) to a working stock of 50 copies/µL, as shown in Table 3.3. 
Make multiple aliquots at once and store at -80°C.

WARNING!
Exercise caution when performing the serial dilutions. Risk of lab contamination is high due to the 
highly concentrated RNA control being used.

1. Prepare a 100-fold dilution by pipetting 990 µL of nuclease-free water into a microfuge 
tube, then adding 10 µL of SARS-CoV-2 RNA Control. Mix well, then centrifuge briefly.

2. Prepare a 10-fold dilution by pipetting 90 µL of nuclease-free water into a microfuge 
tube, then adding 10 µL of the step 1 dilution. Mix well, then centrifuge briefly.

3. Prepare a 10-fold dilution by pipetting 90 µL of nuclease-free water into a microfuge 
tube, then adding 10 µL of step 2 dilution. Mix well, then centrifuge briefly.

4. Pipette 50 µL of nuclease-free water into a microfuge tube, then add 50 µL of Step 3 
dilution. Mix well, then centrifuge briefly.

Table 3.3   Positive Sample Control Dilution

Label with correct copies/µL and store each dilution in aliquots at -80°C. When needed to 
make new positive controls, take one of the tubes and dilute as per table above, from the 
specific copy number down.

3.6  RT-PCR amplification

IMPORTANT!
Prepare the RT-PCR cocktail and add cocktail and samples to the reaction plate in Lab Area 2. 
Thermocycle the RT-PCR reaction plate in Lab Area 3. Maintain an RNase-free environment and 
keep samples on ice during use. Make sure all reagents are thawed completely at room 
temperature and enzymes are kept on ice. Make sure reagents are homogenized before taking 
aliquots. If plates were stored frozen prior to this step, make sure they are thawed completely, 
gently homogenized, spun down, and kept on ice.

1. Turn on the PCR thermal cycler with the program shown in Table 3.6, so that the heated 
cover can come to the correct operating temperature and there is no time delay 
between the RT-PCR reaction plate being prepared and cycling being started.

Step
Final 

concentration 
(copies/μL)

Amount of 
SARS-CoV-2 
RNA Control 

transferred (μL)

Source Nuclease-
free water

Final 
Volume (μL)

Dilutions

1 10,000 10 Stock 990 1,000

2 1,000 10 Step 1 90 100

3 100 10 Step 2 90 100

4 50 50 Step 3 50 100
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2. Prepare the RT-PCR cocktail in a 1.5 mL tube placed on ice or a cold block by adding 
reagents in the order in which they are listed in Table 3.4. 
Prepare more cocktail than the number of RT-PCR reactions to be performed. Either 
prepare for one or more extra reactions or use a percentage extra to ensure sufficient 
overage is present to overcome typical pipetting variation.

Table 3.4   RT-PCR Reaction

3. Pulse vortex the tube briefly 3 times and briefly centrifuge.

4. Dispense 2.0 μL RT-PCR cocktail into each well of a new microtiter plate. 

5. Add 3.0 μL of either sample RNA, positive control, or negative control to each well of 
the plate.

Table 3.5   Samples and Controls

6. Seal the RT-PCR reaction plate, briefly pulse vortex 1-2 times, then centrifuge at 1000 
x g for 15 seconds.

7. Visually inspect the individual wells from the bottom of the reaction plate to confirm 
uniform and adequate cocktail solution is present in every well before continuing.

8. Thermocycle the RT-PCR reaction plate using the conditions in Table 3.6. On a 
standard cycler with a ramp rate of approximately 3-4°C/s this program takes 

Reagent Per Reaction (μL)

10X PCR Buffer 0.500

MgCl2, 25 mM 0.400

dUTP/dNTP Mix 0.100

UNG (heat labile) 0.050

RNase Inhibitor 0.125

PCR Enzyme 0.200

MMLV Enzyme 0.125

MassARRAY SARS-CoV-2 PCR Primer 0.500

RT-PCR Cocktail Final Volume 2.000

Sample RNA/Positive Control/Negative 
Control

3.000

RT-PCR Reaction Final Volume 5.000

Component

Volume per reaction

Sample 
reaction

Positive 
control 

reaction

Negative 
control 

reaction

RT-PCR Cocktail 2.0 μL 2.0 μL 2.0 μL

Purified sample RNA 
(from RNA Extraction section 
above)

3.0 μL -- --

Positive control 
(from Positive Control Preparation 
section above)

-- 3.0 μL --

Purified negative control (from 
RNA Extraction section above) -- -- 3.0 μL

Total volume 5.0 μL 5.0 μL 5.0 μL
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approximately 1 hour and 45 minutes.

Table 3.6   RT-PCR Thermal Cycling Conditions

STOPPING POINT
If not proceeding directly to the next step, the reaction plate should be sealed, and stored at 4°C 
(if storing for less than 24 hours), or at -20°C (if storing for more than 24 hours). Do not store for 
more than 2 weeks.

3.7  SAP reaction

IMPORTANT!
Prepare the SAP cocktail in Lab Area 2. Add the SAP cocktail to the RT-PCR reaction plate and 
thermocycle the plate in Lab Area 3. Make sure all reagents are thawed completely and enzymes 
are kept on ice. Make sure all reagents are homogenized before taking aliquots. If plates were 
stored frozen prior to this step, make sure they are thawed completely, gently homogenized, spun 
down, and kept on ice.

1. Prepare the SAP cocktail in a 1.5 mL tube on ice or a cold block as shown in Table 3.7. 
Prepare more cocktail than the number of SAP reactions to be performed. Either 
prepare for one or more extra reactions or use a percentage extra to ensure sufficient 
overage is present to overcome typical pipetting variation.

Table 3.7   SAP Cocktail

2. Pulse vortex the tube briefly 3 times and briefly centrifuge.

3. Centrifuge the RT-PCR reaction plate at 1000 x g for 15 seconds.

4. Dispense 2 μL of SAP cocktail into each well of the reaction plate. 

5. Seal the reaction plate, briefly pulse vortex 1-2 times, then centrifuge at 1000 x g for 
15 seconds.

Step Temperature Time Number of Cycles

1 UNG incubation 25°C 5 minutes 1 cycle

2 RNA reverse transcription into cDNA 55°C 10 minutes 1 cycle

3 Polymerase activation 95°C 2 minutes 1 cycle

4

PCR to amplify specific fragments

95°C 30 seconds

40 cycles of steps 4-65 60°C 30 seconds

6 72°C 30 seconds

7 Final extension 72°C 5 minutes 1 cycle

8 Sample preservation 10°C -- Hold

Reagent Per reaction (μL)

HPLC-grade water 1.53

SAP Buffer 0.17

Shrimp Alkaline Phosphatase (SAP) 0.30

SAP Cocktail Final Volume 2.00
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6. Visually inspect the individual wells from the bottom of the reaction plate to confirm 
uniform and adequate solution is present in every well before continuing.

7. Thermocycle the reaction plate using the conditions in Table 3.8. On a standard cycler 
with a ramp rate of approximately 3-4°C/s this program takes approximately 15-20 
minutes.

Table 3.8   SAP Cycling Conditions

STOPPING POINT
If not proceeding directly to the next step, the reaction plate should be sealed, and stored at 4°C 
(if storing for less than 24 hours), or at -20°C (if storing for more than 24 hours). Do not store for 
more than 2 weeks.

3.8  iPLEX Pro extension reaction

IMPORTANT!
Prepare the extension reaction cocktail in Lab Area 2. Add the extension reaction cocktail to the 
reaction plate and thermocycle the plate in Lab Area 3. Make sure all reagents are thawed 
completely and enzymes are kept on ice. Make sure all reagents are homogenized before taking 
aliquots. If plates were stored frozen prior to this step, make sure they are thawed completely, 
gently homogenized, spun down, and kept on ice.

1. Prepare the extension cocktail in a 1.5 mL tube on ice or a cold block, as shown in Table 
3.9. Prepare more cocktail than the number of extension reactions to be performed. 
Either prepare for one or more extra reactions per extension or use a percentage extra 
to ensure sufficient overage is present to overcome typical pipetting variation.

Table 3.9   Extension Cocktail

2. Pulse vortex the tube briefly 3 times and briefly centrifuge.

3. Centrifuge the reaction plate at 1000 x g for 15 seconds.

4. Dispense 2 μL of extension reaction cocktail into each well of the reaction plate. 

5. Seal the reaction plate, briefly pulse vortex 1-2 times, then centrifuge at 1000 x g for 
15 seconds.

Step Temperature Time Number of Cycles

1 Dephosphorylation 37°C 10 minutes 1 cycle

2 Enzyme inactivation 85°C 5 minutes 1 cycle

3 Sample preservation 10°C -- Hold

Reagent Per reaction (μL)

HPLC-grade water 0.62

iPLEX Buffer Plus, GPR 0.20

iPLEX Termination Mix 0.20

iPLEX Pro Enzyme 0.04

MassARRAY SARS-CoV-2 Extend Primer 0.94

Extension Cocktail Final Volume 2.00
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6. Visually inspect the individual wells from the bottom of the reaction plate to confirm 
uniform and adequate solution is present in every well before continuing.

7. Thermocycle the reaction plate using the conditions in Table 3.10. On a standard 
cycler with a ramp rate of approximately 3-4°C/s this program takes approximately 45 
minutes.

Table 3.10   Extension Thermal Cycling Conditions

STOPPING POINT
If not proceeding directly to the next step, the reaction plate should be sealed, and stored at 4°C 
(if storing for less than 24 hours), or at -20°C (if storing for more than 24 hours). Do not store for 
more than 2 weeks.

3.9  Water addition

1. Add HPLC-grade water to each well of the reaction plate.

a. For 96-well plates, add 41 μL.

b. For 384-well plates, add 16 μL.

2. Seal the plate and centrifuge at 1000 x g for 1 minute.

STOPPING POINT
If not proceeding directly to processing the plate on the MassARRAY System (), the reaction plate 
should be sealed, and stored at 4°C (if storing for less than 24 hours), or at -20°C (if storing more 
than 24 hours). Do not store for more than 2 weeks.

3.10  Data acquisition

Follow the data acquisition instructions in the chapter for the MassARRAY System you are 
using.

Table 3.11   Data Acquisition Instructions

Step Temperature Time Number of Cycles

1 Initial denaturation 95°C 30 seconds 1 cycle

2 Denaturation 95°C 5 seconds

40 cycles of steps 2-43 Annealing/Extension 52°C 15 seconds

4 Denaturation 80°C 5 seconds

5 Final extension 72°C 3 minutes 1 cycle

6 Sample preservation 10°C -- Hold

System Instructions

MassARRAY System with Chip Prep Module 96 Chapter 4

MassARRAY System with Chip Prep Module 384 Chapter 5
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Chapter 4

Data Acquisition on the MassARRAY System
with Chip Prep Module 96

4.1  Create an input file

1. Double-click the Chip Linker icon on the desktop.

2. In the dialog box that appears, enter your username, password, and server.

3. Click Connect. The Chip Linker window appears.

4. Select a plate in the Chip Linker directory tree.

5. Select iPLEX as the terminator chemistry. 

6. Select Genotype+Area for the process method.

7. Select Nanodispenser 96 to 96 as the dispenser method. 

8. Enter an experiment name.

9. Enter the SpectroCHIP Array barcode or other SpectroCHIP Array identifier.

10. Click Add. The input information appears in the Chip Linker table.

11. If a second SpectroCHIP Array will be processed, repeat step 4 to step 10 for the 
second SpectroCHIP Array.

12. Click Create to create an input XML file. This file will be selected for use when you set 
up the automatic run.

4.2  Prepare the instrument

1. Double-click the Start All icon to start MassARRAY Caller, Analyzer Control, Chip Prep 
Controller (CPC), and SpectroACQUIRE.

2. In the Status section in the Run Setup tab of SpectroACQUIRE check the Waste Tank, 
System Fluid, and Resin buttons; they should be green/Okay. If any are red (Waste 
Tank Full, System Fluid Empty, Resin Low or Empty) perform the necessary 
maintenance. 

3. Click Chip prep module Deck In/Out at the top of the SpectroACQUIRE window. The 
deck will extend.

4. If there are SpectroCHIP Arrays in the completed chips position on the deck remove 
them.

5. Allow the calibrant to equilibrate to room temperature for 5 minutes (if it has been 
refrigerated) or 10 minutes (if it has been frozen). Pipette 75 μL of calibrant into the 
calibrant vial and place in the calibrant vial holder on the deck.

6. Load the SpectroCHIP Arrays.

a. Orient the Chip holder so that the bevelled corner is at the top right.

b. Open a new SpectroCHIP Array pouch and insert the new SpectroCHIP Array into 
the chip holder in position 1 (on the left); orient the SpectroCHIP Array such that 
the Agena logo and barcode are at the bottom. Make sure that the SpectroCHIP 
Array is properly seated so that the chip holder and SpectroCHIP Array surface 
are flush.
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c. If you are processing two plates, insert another new SpectroCHIP Array into the 
chip holder in position 2 (on the right). If you are only processing one plate, place 
a previously completed SpectroCHIP Array in position 2, as the MassARRAY 
Analyzer requires both SpectroCHIP Array positions to be filled to function 
properly.

d. Place the full chip holder in the chip holder tray, new chips position, on the deck.

7. Load microtiter plates (MTPs). Up to two 96-well microtiter plates of analyte may be 
loaded.

WARNING!
The Chip Prep Module is configured at installation for the particular plates you will be using. If at 
any point you wish to change the plates you are using, contact Agena Bioscience Customer 
Support to update instrument configuration. Using plates with different well depth without 
reconfiguration can damage the instrument or compromise assay performance.

a. Centrifuge the plates at 1000 x g for 1 minute.

b. Place the first MTP on MTP holder 1 (on the left). This corresponds to chip position 
1. Orient the plate such that well A1 is in the front left corner.

c. If a second MTP is being processed, place it on MTP holder 2 (on the right). This 
corresponds to chip position 2.

8. Click Chip prep module Deck In/Out again to retract the deck.

4.3  Set up and start the run

WARNING!
Confirm that instrument settings are correct, as shown in the tables below, prior to each run.

1. Select the Run Setup tab in SpectroACQUIRE.

2. In the Experiment Setup section:

a. Under MTP 1, click on the browse button next to Experiment Name and select the 
XML input file created earlier.

b. In the Wells to Process field, select Automatic.

c. Repeat steps 1 and 2 for MTP 2 if running two plates. Otherwise, select None in 
the Experiment Name and Wells to Process fields for MTP 2.

d. Enter the settings for the SpectroCHIP type being used, as shown in Table 4.1.

Table 4.1   Experiment Setup Settings

3. In the Analyzer Setup section:

a. Select Tools > Load Parameters on the SpectroACQUIRE toolbar, then select the 
appropriate parameter file based on the SpectroCHIP type. Acquisition 
parameters will automatically populate. 

b. Make sure all settings in this section are as shown in Table 4.2.

Setting Value

Use Autotune Selected

Start Dispense Condition 600

Resin Volume 13

Sample Volume n/a
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Table 4.2   Analyzer Setup Settings

4. In the Chip Prep Module Setup section:

a. Check the Normal Operation box.

b. Check MTP Barcodes Required, if desired.

c. Select iPLEX in the Chemistry drop-down menu.

5. In the Temperature Control section:

a. If the MTP and calibrant will not be removed from the instrument shortly after the 
run is completed, select the MTP Cool box, and check the Auto box. 

b. Check the Chip Heat box and enter 30 in the Setpoint field.

6. If desired, enter your email and check the When Chip prep module is finished and 
When MA4 is finished boxes to receive email notifications.

7. Click Start Chip prep module to start the run.

4.4  Remove plates, calibrant, and SpectroCHIP Arrays when run is complete

1. Once the run is completed, click Chip prep module Deck In/Out to move the deck out 
and remove the MTPs and calibrant vial. Store remaining calibrant refrigerated or frozen 
for future use.

2. Click Remove Old Chips from MA4 in the Run Setup tab. The instrument will move 
the completed SpectroCHIP Arrays from the MassARRAY Analyzer to the completed 
chips position on the Chip Prep Module deck, and then extend the deck so you may 
remove the SpectroCHIP Arrays from the completed chips position.

Setting Value

Parameter file name iPLEX_CPM.par

Shots (n) 30

Maximum acquisitions 9

Minimum good spectra 5

Maximum good spectra 5

Turn Off HV After Analysis Selected

Analyze Calibrant Pads Selected

Filter Saturated Shots Selected

Chip Type SpectroCHIP CPM-96
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Chapter 5

Data Acquisition on the MassARRAY System
with Chip Prep Module 384

5.1  Create an input file

1. Double-click the Chip Linker icon on the desktop.

2. In the dialog box that appears, enter your username, password, and server.

3. Click Connect. The Chip Linker window appears.

4. Select a plate in the Chip Linker directory tree.

5. Select iPLEX as the terminator chemistry. 

6. Select Genotype+Area for the process method.

7. Select Nanodispenser 384 to 384 as the dispenser method. 

8. Enter an experiment name.

9. Enter the SpectroCHIP Array barcode or other SpectroCHIP Array identifier.

10. Click Add. The input information appears in the Chip Linker table.

11. If a second SpectroCHIP Array will be processed, repeat step 4 to step 10 for the 
second SpectroCHIP Array.

12. Click Create to create an input XML file. This file will be selected for use when you set 
up the automatic run.

5.2  Prepare the instrument

1. Double-click the Start All icon to start MassARRAY Caller, Analyzer Control, Chip Prep 
Controller (CPC), and SpectroACQUIRE.

2. In the Status section in the Run Setup tab of SpectroACQUIRE check the Waste Tank, 
System Fluid, and Resin buttons; they should be green/Okay. If any are red (Waste 
Tank Full, System Fluid Empty, Resin Low or Empty) perform the necessary 
maintenance. 

3. Click Chip prep module Deck In/Out at the top of the SpectroACQUIRE window. The 
deck will extend.

4. If there are SpectroCHIP Arrays in the completed chips position on the deck remove 
them.

5. Allow the calibrant to equilibrate to room temperature for 5 minutes (if it has been 
refrigerated) or 10 minutes (if it has been frozen). Pipette 75 μL of calibrant into the 
calibrant vial and place in the calibrant vial holder on the deck.

6. Load the SpectroCHIP Arrays.

a. Orient the Chip holder so that the bevelled corner is at the top right.

b. Open a new SpectroCHIP Array pouch and insert the new SpectroCHIP Array into 
the chip holder in position 1 (on the left); orient the SpectroCHIP Array such that 
the Agena logo and barcode are at the bottom. Make sure that the SpectroCHIP 
Array is properly seated so that the chip holder and SpectroCHIP Array surface 
are flush.
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c. If you are processing two plates, insert another new SpectroCHIP Array into the 
chip holder in position 2 (on the right). If you are only processing one plate, place 
a previously completed SpectroCHIP Array in position 2, as the MassARRAY 
Analyzer requires both SpectroCHIP Array positions to be filled to function 
properly.

d. Place the full chip holder in the chip holder tray, new chips position, on the deck.

7. Load microtiter plates (MTPs). Up to two 384-well microtiter plates of analyte may be 
loaded.

WARNING!
The Chip Prep Module is configured at installation for the particular plates you will be using. If at 
any point you wish to change the plates you are using, contact Agena Bioscience Customer 
Support to update instrument configuration. Using plates with different well depth without 
reconfiguration can damage the instrument or compromise assay performance.

a. Centrifuge the plates at 1000 x g for 1 minute.

b. Place the first MTP on MTP holder 1 (on the left). This corresponds to chip position 
1. Orient the plate such that well A1 is in the front left corner.

c. If a second MTP is being processed, place it on MTP holder 2 (on the right). This 
corresponds to chip position 2.

8. Click Chip prep module Deck In/Out again to retract the deck.

5.3  Set up and start the run

WARNING!
Confirm that instrument settings are correct, as shown in the tables below, prior to each run.

1. Select the Run Setup tab in SpectroACQUIRE.

2. In the Experiment Setup section:

a. Under MTP 1, click on the browse button next to Experiment Name and select the 
XML input file created earlier.

b. In the Wells to Process field, select Automatic.

c. Repeat steps 1 and 2 for MTP 2 if running two plates. Otherwise, select None in 
the Experiment Name and Wells to Process fields for MTP 2.

d. Enter the settings as shown in Table 5.1.

Table 5.1   Experiment Setup Settings

3. In the Analyzer Setup section:

a. Select Tools > Load Parameters on the SpectroACQUIRE toolbar, then select the 
appropriate parameter file based on the SpectroCHIP type. Acquisition 
parameters will automatically populate. 

Value

Use Autotune Selected

Start Dispense Condition Default (350)

Resin Volume 10

Sample Volume n/a
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b. Make sure all settings in this section are as shown in Table 5.2.

Table 5.2   Analyzer Setup Settings

4. In the Chip Prep Module Setup section:

a. Check the Normal Operation box.

b. Check MTP Barcodes Required, if desired.

c. Select iPLEX in the Chemistry drop-down menu.

5. In the Temperature Control section:

a. If the MTP and calibrant will not be removed from the instrument shortly after the 
run is completed, select the MTP Cool box, and check the Auto box. 

b. Check the Chip Heat box and enter 30 in the Setpoint field.

6. If desired, enter your email and check the When Chip prep module is finished and 
When MA4 is finished boxes to receive email notifications.

7. Click Start Chip prep module to start the run.

5.4  Remove plates, calibrant, and SpectroCHIP Arrays when run is complete

1. Once the run is completed, click Chip prep module Deck In/Out to move the deck out 
and remove the MTPs and calibrant vial. Store remaining calibrant refrigerated or frozen 
for future use.

2. Click Remove Old Chips from MA4 in the Run Setup tab. The instrument will move 
the completed SpectroCHIP Arrays from the MassARRAY Analyzer to the completed 
chips position on the Chip Prep Module deck, and then extend the deck so you may 
remove the SpectroCHIP Arrays from the completed chips position.

Value

Parameter file name iPLEX_CPM.par

Shots (n) 30

Maximum acquisitions 9

Minimum good spectra 5

Maximum good spectra 5

Turn Off HV After Analysis Selected

Analyze Calibrant Pads Selected

Filter Saturated Shots Selected

Chip Type SpectroCHIP CPM-384
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Chapter 6

Analysis and Results

6.1  Analyze the data

1. Open MassARRAY Typer Analyzer and in the Project Explorer pane double click on the 
SpectroCHIP Arrays of interest. The SpectroCHIP Arrays will be added to the Chip List.

2. Load the SpectroCHIP Arrays by checking the box next to the SpectroCHIP Array 
names in the Chip List.

3. Select File > Reports > MassARRAY SARS-CoV-2 Report-v1 in the MassARRAY 
Typer Analyzer menu bar.

When the report is complete, the MassARRAY SARS-CoV-2 Report Details.csv will 
automatically open, and the results will be made available in a date- and time-stamped 
folder in the MassARRAY/Typer/bin/TyperReports/MassARRAY SARS-CoV-2 Report folder.

6.2  Interpretation of the results

Interpretation of 
MassARRAY SARS-
CoV-2 Panel Controls

The results from testing control samples are interpreted according to the criteria 
described in Table 6.1. 

Table 6.1   Interpretation of MassARRAY SARS-CoV-2 Panel Controls 

ND=Not Detected; D=Detected
*Can be ND if SARS-CoV-2 is Detected in at least >2 assays.
**PC will pass QC only if it is Detected by all targets
***NC will pass QC only it is Not Detected by all targets

Control Type External Control 
Name N1 N2 N3 ORF1 ORF1ab MS2

Negative*** Negative Control ND ND ND ND ND D

Positive** Positive Control D D D D D ND

Extraction MS2 Control n/a n/a n/a n/a n/a D*
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Examination and 
interpretation of 
patient specimen 
results

Interpretation of the results is performed by the MassARRAY SARS-CoV-2 Report 
software.

Assessment of clinical specimen test results must be performed after the positive and 
negative controls (included on each plate) have been examined and determined to be 
valid and acceptable (i.e., QCStatus = PASS). If the controls are not valid, the patient 
results cannot be interpreted. The results from testing of patient samples are interpreted 
according to the criteria described in Table 6.2.

Table 6.2   Expected Results for MassARRAY SARS-CoV-2 Panel Patient Specimens

*Refer to Action column for operator response when QC status is WARNING.

N1 N2 N3 ORF1 ORF1
ab MS2 QC Status Result Interpretation Report Action

Any 2 or more (+) (+) PASS
MS2 is detected, and 2 or 
more SARS-CoV-2 assays 

detected, result is Detected

SARS-CoV-2 
Detected Report results

Any 1 (+) (+) PASS
MS2 is detected, and only 1 

SARS-CoV-2 assay detected, 
result is Inconclusive

SARS-CoV-2 
Inconclusive

Repeat test on 
original sample. If 
the repeat result 
remains 
inconclusive, report 
results. Additional 
confirmation testing 
should be 
conducted if 
clinically indicated.

None (+) (+) PASS
MS2 is detected, and 0 SARS-
CoV-2 assays detected, result 

is Not Detected

SARS-CoV-2 
NotDetected

Report results. 
Consider testing for 
other viruses.

Any 2 or more (+) (-) WARNING*
MS2 is not detected, and 2 or 

more SARS-CoV-2 assays 
detected, result is Detected

SARS-CoV-2 
Detected Report results.

Any 1 (+) (-) WARNING*
MS2 is not detected, and only 
1 SARS-CoV-2 assay detected, 

result is Inconclusive

SARS-CoV-2 
Inconclusive

Repeat test on 
original sample. If 
the repeat result 
remains 
inconclusive, report 
results. Additional 
confirmation testing 
should be 
conducted if 
clinically indicated.

None (+) (-) FAIL
MS2 is not detected, and 0 

SARS-CoV-2 assays detected, 
result is Invalid

Invalid

Repeat test on 
original sample. If 
the repeat result 
remains invalid, 
consider collecting a 
new specimen.
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Chapter 7

Performance Characteristics

7.1  Limit of detection (LoD)

This LoD study established the lowest SARS-CoV-2 viral concentration (copies of SARS-
CoV-2 RNA per uL of clinical matrix) that can be detected by the MassARRAY SARS-CoV-
2 Panel at least 95% of the time. Negative screened NP pooled clinical matrix in VTM by 
the MassARRAY SARS-CoV-2 Panel test was used for analytical sensitivity studies. The 
negative screen NP pool clinical matrix in VTM was spiked with heat inactivated SARS-
CoV-2 virus (BEI Resources, part number NR52286) at specified concentrations and 
processed through the MassARRAY SARS-CoV-2 Panel workflow on both the 
MassARRAY System with Chip Prep Module (CPM) 96 and the MassARRAY System with 
Chip Prep Module (CPM) 384 as described in Chapters 2-5. A two-phase approach was 
used to determine the LoD.

On the MassARRAY 
System with CPM 96

Phase One
Preliminary LoD determination was performed testing 3 replicates of 2-fold dilution of 
heat inactivated SARS-CoV-2 virus (BEI Resources, part number NR52286) at 0.08 
copies/μL, 0.16 copies/μL, 0.31 copies/μL, 0.63 copies/μL, 1.25 copies/μL, 2.5 copies/μL, 5 
copies/μL and 10 copies /μL. The preliminary LoD was determined at 0.31 copies/μL. See 
Table 7.1.

Table 7.1   Preliminary LoD Determination Study Results, CPM 96 Phase 1

Phase Two
NP specimen LoD was confirmed at 2.5 copies/μL with 20 out of 20 replicates detected. 
See Table 7.2.

Table 7.2   LoD Determination Study Results, CPM 96 Phase 2 

SARS-CoV-2 copies/μL # Detected/Total Replicates % Positive

0 0/20 0%

0.08 1/3 33%

0.16 0/3 0%

0.31 3/3 100%

0.63 3/3 100%

1.25 3/3 100%

2.50 3/3 100%

5.00 3/3 100%

10.00 3/3 100%

SARS-CoV-2 copies/μL # Detected/Total Replicates % Positive

0 0/20 0%

0.31 7/20 35%

0.63 12/20 60%

1.25 18/20 90%

2.50 20/20 100%
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On the MassARRAY 
System with CPM 384

Phase One
Preliminary LoD determination was performed testing 5 replicates of 2-fold dilution of 
heat inactivated SARS-CoV-2 virus (BEI Resources, part number NR52286) at 0.313 
copies/µL, 0.625 copies/µL, 1.25 copies/µL, 2.5 copies/µL, 3.75 copies/µL, and 
5 copies/µL). The preliminary LoD was determined at 1.25 copies/µL. See Table 7.3.

Table 7.3   Preliminary LoD Determination Study Results, CPM 384 Phase 1

Phase Two
NP specimen LoD was confirmed at 2.5 copies/μL with 20 out of 20 replicates detected. 
See Table 7.4.

Table 7.4   LoD Determination Study Results, CPM 384 Phase 2 

7.2  Inclusivity

Homology verification (inclusivity) was carried out using the sequence data from 18,772 
complete SARS-CoV-2 genomes (NCBI 6OCT2020). A multiple sequence alignment 
(MAFFT version 7) was carried out to generate the consensus sequence, which was used 
to determine conserved regions of the virus. All assay components listed in Table 7.5 
showed 100% sequence homology except for the forward PCR primer for the SC2_N2 
assay (see Table 7.5).

According to the in-silico analysis (6OCT2020), 32% of the SARS-CoV-2 sequences have 
a novel multi-nucleotide polymorphism that overlaps with the first three 5’ end 
nucleotides of the SC2_N2 forward PCR primer (AAC vs. GGG at the 5’ end of the 22 total 
nucleotides). This results in the 86% PCR primer homology (3-nucleotide mismatch in a 
22-nucleotide primer) for the 32% of SARS-CoV-2 population with the AAC sequence, 
resulting in a 95.5% average homology for the SC2_N2 forward PCR primer to all 
available SARS-CoV-2 sequences as of October 6, 2020 (18,772). The mismatch will not 
affect the test performance because of the following:

•   The mismatch is located at the 5’ end of the PCR primer and will be tolerated by the 
PCR enzyme.

SARS-CoV-2 copies/μL # Detected/Total Replicates % Positive

0 0/20 0

0.313 0/5 0

0.625 2/5 40

1.250 5/5 100

2.500 5/5 100

3.750 5/5 100

5.000 5/5 100

SARS-CoV-2 copies/μL # Detected/Total Replicates % Positive

0 0/20 0

1.250 18/20 90

1.875 18/20 90

2.500 20/20 100
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•   The annealing temperature of the primer with the mismatch is 59 °C (Table 7.7), 
which is very close to the optimal 60 °C.

•   The mismatch is localized to the codon substitution and we do not anticipate it to 
affect other nucleotides in the primer.

•   The panel contains five SARS-CoV-2 target assays to remain robust in cases of 
underling mutations.

Table 7.5   MassARRAY SARS-CoV-2 Panel In-Silico Inclusivity Analysis Results

*PCR1 is forward primer and PCR2 is reverse primer.
**95.5% average sequence homology as of 6OCT2020 as discussed above. [=(0.86x0.32)+(1x0.68)]

7.3  Cross-reactivity

In-silico cross-reactivity was carried out with NCBI nucleotide BLAST with a list of FDA-
recommended cross-reactivity micro-organisms (Table 7.6). The analysis was carried out 
on 6OCT2020 versions of the microbial NCBI database with identical results. The in-silico 
homology to cross-reactivity micro-organisms is the primer-length adjusted BLAST 
homology. The highest non-CoV-2 homology and the specie (from the FDA list of cross-
reactive microorganisms, Table 7.6) are listed in Table 7.7.

Components of three assays (forward primer and probe for N1 assay, forward primer for 
N2 assay, and probe for ORF1ab assay) exhibit greater than the 80% homology to a listed 
evaluation species. However, the risk of non-specific amplification and an erroneous 
detection of non-SARS-CoV-2 RNA is very small in all three cases. Agena iPLEX 
technology is a two-step process where an initial PCR step is followed by a probe 
extension step. Therefore, the assay PCR primers are used to initiate cDNA syntheses 
and amplify the template library while the probes are used to interrogate the template via 

Primer*/Probe
Minimum % 

Identity
Maximum 

Mismatches
Total 

Alignments

Number of 
Alignments 

with 
Mismatches

% Alignments 
with 100% 

Identity

Mismatch 
Accession 
Numbers 

SC2_N1_PCR1 100 0 18.772 0 100

SC2_N1_PCR2 100 0 18.772 0 100

SC2_N1_PROBE 100 0 18.772 0 100

SC2_N2_PCR1 95.5** 3/22 18.772 5,978 68
Codon 50, ORF14, 
positions 28,881-

28,883

SC2_N2_PCR2 100 0 18.772 0 100

SC2_N2_PROBE 100 0 18.772 0 100

SC2_N3_PCR1 100 0 18.772 0 100

SC2_N3_PCR2 100 0 18.772 0 100

SC2_N3_PROBE 100 0 18.772 0 100

SC2_ORF1_PCR1 100 0 18.772 0 100

SC2_ORF1_PCR2 100 0 18.772 0 100

SC2_ORF1_PROBE 100 0 18.772 0 100

SC2_ORF1ab_PCR1 100 0 18.772 0 100

SC2_ORF1ab_PCR2 100 0 18.772 0 100

SC2_ORF1ab_PROBE 100 0 18.772 0 100
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a single-base extension. The RT-PCR and the extend steps instill target specificity and 
remove the deleterious PCR-probe primer interaction.

Following is an analysis of the cross-reactivity results for the three assays that exhibit 
>80% homology in at least one of their components:

•   SC2_N1 assay. Two SC2_N1 assay components (forward primer and probe) exhibit 
>80% in silico homology to a listed organism (SARS-coronavirus). However, the 
cross-reactive assay components are not the PCR primers, but a combination of 
one PCR primer and the probe. The forward primer showed 82% homology while 
the reverse primer showed 75% homology and the probe showed 94% homology 
to SARS-coronavirus. The SC2_N1 reverse primer shows low homology, therefore 
the risk of non-specific PCR amplification of SARS-coronavirus is low. This is 
confirmed by the NCBI Primer BLAST. Furthermore, reverse transcription of RNA 
into DNA requires high reverse PCR primer homology. Low homology of the 
reverse primer further reduces non-specific reverse-transcription and subsequent 
amplification.

•   SC2_N2 assay. One SC2_N2 assay component (forward primer) exhibits >80% 
homology to a listed organism (SARS-coronavirus). The forward PCR primer 
showed 91% homology while the reverse primer showed 68% homology and the 
probe showed 55% homology to SARS-coronavirus. The SC2_N2 reverse primer 
and probe show low homology, therefore the risk of non-specific PCR amplification 
and probe extension of SARS-coronavirus is low. This is confirmed by the NCBI 
Primer BLAST. Furthermore, reverse transcription of RNA into DNA requires high 
reverse PCR primer homology. Low homology of the reverse primer further 
reduces non-specific reverse-transcription and subsequent amplification.

•   -SC2_ORF1ab assay. One SC2_ORF1ab assay component (probe) exhibits >80% 
homology to a listed organism (SARS-coronavirus). The probe showed 88% 
homology while the forward primer showed 76% and the reverser primer showed 
37% homology to SARS-coronavirus. The SC2_ORF1ab forward and reverse 
primers show low homology, therefore risk of non-specific PCR amplification of 
SARS-coronavirus is low. This is confirmed by the NCBI Primer BLAST. Furthermore, 
reverse transcription of RNA into DNA requires high reverse PCR primer homology. 
Low homology of the reverse primer further reduces non-specific reverse-
transcription and subsequent amplification.
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Table 7.6   List of Organisms Analyzed in Silico Cross-Reactivity

Other high priority pathogens from the 
same genetic family

High priority organisms likely present in a 
respiratory specimen

Human coronavirus 229E Adenovirus (e.g., C1 Ad. 71)

Human coronavirus OC43 Human Metapneumovirus (hMPV)

Human coronavirus HKU1 Parainfluenza virus 1-4

Human coronavirus NL63 Influenza A & B

SARS-coronavirus Enterovirus (e.g., EV68)

MERS-coronavirus Respiratory syncytial virus 

Rhinovirus

Chlamydia pneumoniae

Haemophilus influenzae

Legionella pneumophila

Mycobacterium tuberculosis

Streptococcus pneumoniae

Streptococcus pyogenes

Bordetella pertussis

Mycoplasma pneumoniae

Pneumocystis jirovecii (PJP)

Pooled human nasal wash – to represent 
diverse microbial flora in the human respiratory 
tract

Candida albicans

Pseudomonas aeruginosa

Staphylococcus epidermidis

Streptococcus salivarius
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Table 7.7   MassARRAY SARS-CoV-2 Panel in Silico Cross-Reactivity

*PCR1 is forward primer and PCR2 is reverse primer.

**95.5 average sequence homology as of 6OCT2020 as discussed in section Section 7.2, Inclusivity. 
[=(0.86x0.32)+(1x0.68)].

Assay 
Name

Assay Primer*
Annealing 

Temperature 
(°C)

Sequence

SARS-
CoV-2 

Homology 
%

Highest 
Other 
Specie 

Homology 
%

Highest 
Other 
Specie 

from FDA 
List (Table 

7.6)

SC2_N1

SC2_N1_PCR1 65 TGAGGAAGTTGTAGCACGATTG 100 82 SARS-
coronavirus

SC2_N1_PCR2 65 AGACGGCATCATATGGGTTG 100 75 SARS-
coronavirus

SC2_N1_PROBE 59 GTGCCAATGTGATCTTT 100 94 SARS-
coronavirus

SC2_N2

SC2_N2_PCR1 66 (59 with 3-base 
5-prime mismatch) GGGGAACTTCTCCTGCTAGAAT 95.5** 91 SARS-

coronavirus

SC2_N2_PCR2 64 CAGACATTTTGCTCTCAAGCTG 100 68 SARS-
coronavirus

SC2_N2_PROBE 69 GCAAAGCAAGAGCAGCATCACC 100 55
Human 

Coronavirus 
NL63

SC2_N3

SC2_N3_PCR1 64 GTGGATGAGGCTGGTTCTAA 100 60 MERS-
coronavirus

SC2_N3_PCR2 59 ACTACAAGACTACCCAATTT 100 60 MERS- 
coronavirus

SC2_N3_PROBE 57 GAAACTGTATAATTACCGATA 100 57
Human 

coronavirus 
HKU1

SC2_ORF1

SC2_ORF1_PCR1 63 AACTGTTGGTCAACAAGACG 100 55
Enterovirus F 
strain BEV-

261

SC2_ORF1_PCR2 63 CAATAGTCTGAACAACTGGTGT 100 50
Staphylococc

us phage 
tp310-3

SC2_ORF1_PROB
E 56 GGTTCAACCTCAATTAG 100 76

Possum 
enterovirus 

W1

SC2_ORF1ab

SC2_ORF1ab_PC
R1 63 CCCTGTGGGTTTTACACTTAA 100 76 SARS-

coronavirus

SC2_ORF1ab_PC
R2 65 ACGATTGTGCATCAGCTGA 100 68 Enterovirus 

SEV-gx

SC2_ORF1ab_PR
OBE 65 ATCAACTCCGCGAACCC 100 88 SARS-

coronavirus

MS2_Ctrl

MS2_Ctrl_PCR1 65 TTGACAATCTCTTCGCCCTG - 55
Enterovirus 

AN12 
genomic RNA

MS2_Ctrl_PCR2 64 CTGACATACCTCCGACAACT - 50 SARS-CoV-2

MS2_Ctrl_PROBE 70 CCCAACCCCGTAGCCGATT - 58

Human 
rhinovirus 
NAT001 

polyprotein 
gene
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7.4  Warnings and precautions

•   For In Vitro Diagnostic Use.

•   For use under Emergency Use Authorization (EUA) Only.

•   For prescription use only.

•   This test has not been FDA cleared or approved.

•   This test has been authorized by FDA under an EUA for use by authorized 
laboratories.

•   This test has been authorized only for the detection of nucleic acid from SARS-CoV-
2, not for any other viruses or pathogens.

•   This test is only authorized for the duration of the declaration that circumstances 
exist justifying the authorization of emergency use of in vitro diagnostics for 
detection and/or diagnosis of COVID-19 under Section 564 (b) (1) of the Federal 
Food, Drug, and Cosmetic Act, 21 U.S.C § 360bbb-3(b)(1), unless the authorization is 
terminated or revoked sooner. 

•   Care must be taken to avoid mislabeling/misidentifying samples.

•   Reduced sample input can adversely affect ability to detect SARS-CoV-2 virus.

•   Do not eat, drink, smoke, or apply cosmetic products in the work areas.

•   Positive results are indicative of SARS-CoV-2 RNA.

•   Laboratories within the United States and its territories are required to report all 
results to the appropriate public health authorities.

•   For use only with personnel trained in techniques of reverse transcriptase-PCR and 
in vitro diagnostic procedures.

•   Specimen processing should be performed in accordance with national biological 
safety regulations.

•   If infection with COVID-19 is suspected, specimens should be collected with 
appropriate infection control precautions. 

•   Always use pipette tips with aerosol barriers. Tips that are used must be sterile and 
free of DNases and RNases. 

•   Samples and controls should always be treated as if infectious and/or biohazardous 
in accordance with safe laboratory procedures.

•   Follow necessary precautions when handling samples. Use personal protective 
equipment (PPE) consistent with current guidelines for the handling of potentially 
infectious samples.

•   Dispose of waste in compliance with local, state, and federal regulations.

•   All human-sourced materials should be considered potentially infectious and 
should be handled with universal precautions. If spillage occurs, immediately 
disinfect with a freshly prepared solution of 0.5% sodium hypochlorite in distilled or 
deionized water (dilute household bleach 1:10) or follow appropriate site 
procedures.

•   Fresh clean gloves must be worn in each area and must be changed before leaving 
that area.

•   Do not pipette by mouth.
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•   Safety Data Sheets (SDS) are available on the Agena customer support portal, or by 
contacting Customer Support.

•   Modifications to assay reagents, assay protocol, or instrumentation are not 
permitted.

•   Do not use the kit or any kit components past the expiration date indicated on the 
kit carton label.

•   In the event of damage to the protective packaging, consult the Safety Data Sheet 
(SDS) for instructions.

•   Reagents must be stored as specified in Table 1.3 or by their manufacturer.

•   Ensure all equipment utilized is calibrated and maintained according to 
manufacturer instructions.

7.5  Limitations

•   This device may not be able to differentiate newly emerging SARS-CoV-2 subtypes.

•   Analyte targets (viral sequences) may persist in vivo, independent of virus viability. 
Detection of analyte target(s) does not imply that the corresponding virus(es) are 
infectious or are the causative agents for clinical symptoms.

•   All results from this and other tests must be considered in conjunction with the 
clinical history, epidemiological data, and other data available to the clinician 
evaluating the patient.

•   Samples (nasopharyngeal swab, oropharyngeal swab, nasal and mid-turbinate 
swabs, nasal and nasopharyngeal aspirate, and bronchoalveolar lavage) must be 
collected, transported, and stored using appropriate procedures and conditions, as 
outlined in CDC guidelines (https:// www.cdc.gov/coronavirus/2019-ncov/lab/
guidelines-clinical-specimens.html). Improper collection, transport, or storage of 
samples may hinder the ability of the assay to detect the target sequences.

•   The performance of the MassARRAY SARS-CoV-2 Panel was established using 
nasopharyngeal swabs (NP) samples. Oropharyngeal swabs, nasal and mid-
turbinate swabs, nasal and nasopharyngeal aspirate, and bronchoalveolar lavage 
(BAL) samples are also considered acceptable sample types for use with the 
MassARRAY SARS-CoV-2 Panel, but performance has not been established.

•   Extraction and amplification of nucleic acid from clinical samples must be 
performed according to the specified methods listed in this procedure. Other 
extraction approaches and processing systems have not been evaluated.

•   This test is a qualitative test and does not provide the quantitative value of 
detected organisms present.

•   There is a risk of false positive values resulting from:

• Cross-contamination by target organisms, their nucleic acids or amplified 
product, or from non-specific signals in the assay.

• Cross-contamination during sample handling or preparation. 

• Cross-contamination between patient samples. 

• Sample mix up. 

• RNA contamination during product handling. 
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•   There is a risk of false negative values due to:

• The presence of sequence variants in the pathogen targets of the assay, 
procedural errors, amplification inhibitors in samples, or inadequate numbers 
of organisms for amplification. 

• Improper sample collection.

• Sample mix up.

• Degradation of the SARS-CoV-2 RNA during shipping/storage.

• Sample collection does not collect SARS-CoV-2 RNA.

• Using unauthorized extraction or assay reagents. 

• The presence of RT-PCR inhibitors.

• Mutation in the SARS-CoV-2 virus.

• Failure to follow instructions for use.

•   The impacts of vaccines, antiviral therapeutics, antibiotics, chemotherapeutic or 
immunosuppressant drugs have not been evaluated. 

•   This test cannot rule out infections caused by other viral or bacterial pathogens not 
present on this panel.

•   Negative results do not preclude infection with SARS-CoV-2 virus, and should not 
be the sole basis of a patient management decision. 

•   This device has been evaluated for use with human sample material only.

•   The performance of this device has not been evaluated for patients without signs 
and symptoms of infection.

•   The performance of this device has not been evaluated for monitoring treatment of 
infection.

•   Based on the in-silico cross-reactivity analysis, other SARS-like coronaviruses in the 
same subgenus (Sarbecovirus) as SARS-CoV-2 may cross-react with MassARRAY 
SARS-CoV-2 Panel. Other SARS-like coronaviruses in the same subgenus 
(Sarbecovirus) as SARS-CoV-2 are not known to be currently circulating in the 
human population, and therefore are highly unlikely to be present in patient 
specimens.

7.6  Conditions of authorization for laboratory

The MassARRAY SARS-CoV-2 Panel Letter of Authorization, along with the authorized 
Fact Sheet for Healthcare Providers, the authorized Fact Sheet for Patients, and 
authorized labeling, are available on the FDA website: https://www.fda.gov/medical-
devices/coronavirus-disease-2019-covid-19-emergency-use-authorizations-
medical-devices/vitro-diagnostics-euas.

However, to assist clinical laboratories using the MassARRAY SARS-CoV-2 Panel (“your 
product” in the conditions below), the relevant Conditions of Authorization are listed 
below: 

A. Authorized laboratories1 using your product will include with test result reports, all 
authorized Fact Sheets. Under exigent circumstances, other appropriate methods for 
disseminating these Fact Sheets may be used, which may include mass media.

https://www.fda.gov/medical-devices/coronavirus-disease-2019-covid-19-emergency-use-authorizations-medical-devices/vitro-diagnostics-euas
https://www.fda.gov/medical-devices/coronavirus-disease-2019-covid-19-emergency-use-authorizations-medical-devices/vitro-diagnostics-euas
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B. Authorized laboratories using your product will use your product as outlined in the 
MassARRAY SARS-CoV-2 Panel Instructions for Use (IFU-CUS-001). Deviations from the 
authorized procedures, including the authorized instruments, authorized extraction 
methods, authorized clinical specimen types, authorized control materials, authorized 
other ancillary reagents and authorized materials required to use your product are not 
permitted.

C. Authorized laboratories that receive your product will notify the relevant public health 
authorities of their intent to run your product prior to initiating testing. 

D. Authorized laboratories using your product will have a process in place for reporting 
test results to healthcare providers and relevant public health authorities, as appropriate. 

E. Authorized laboratories will collect information on the performance of your product 
and report to DMD/OHT7-OIR/OPEQ/CDRH (via email: CDRH-EUA-
Reporting@fda.hhs.gov) and Agena Bioscience (1-858-882-2800; 
helpdesk@AgenaBio.com) any suspected occurrence of false positive or false negative 
results and significant deviations from the established performance characteristics of 
your product of which they become aware.

F. All laboratory personnel using your product must be appropriately trained in molecular 
and mass spectrometry techniques and use appropriate laboratory and personal 
protective equipment when handling this kit, and use your product in accordance with 
the authorized labeling.

G. You, authorized distributors, and authorized laboratories using your product will 
ensure that any records associated with this EUA are maintained until otherwise notified 
by FDA. Such records will be made available to FDA for inspection upon request.

1 The letter of authorization refers to, “Laboratories certified under the Clinical Laboratory 
Improvement Amendments of 1988 (CLIA), 42 U.S.C. §263a, to perform high complexity 
tests” as “authorized laboratories.”

7.7  Clinical evaluation

Two clinical evaluation studies were performed to evaluate the performance of the 
MassARRAY SARS-CoV-2 Panel for testing nasopharyngeal (NP) swab specimens from 
patients suspected of COVID-19 by their health providers concurrently with another Real-
Time RT-PCR kit authorized by the FDA.

Pre-authorization study A total of 63 positive and 60 negative specimens in VTM were tested. The samples were 
randomized, blinded, and tested with the MassARRAY SARS-CoV-2 Panel as described in 
Chapters 2-5. 

All negative samples were tested negative. Of the positive samples, 56 tested positive, 3 
tested negative, and 4 tested Inconclusive. Of the 4 Inconclusive samples, 1 was retested 
and found to be positive; 3 were unable to be retested due to insufficient sample volume 
and were excluded from the analyses. Table 7.8 provides a summary of the clinical 
evaluation results. 
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Table 7.8   Performance of the MassARRAY SARS-CoV-2 Panel Against EUA Comparator Test (pre-authorization 
study

1Three (3) samples were not detected with the MassARRAY SARS-CoV-2 Panel and were detected by the 
comparator SARS-CoV-2 assay. These 3 false negative samples had low viral load with high Ct values with the 
comparator SARS-CoV-2 assay.

2Three (3) samples had inconclusive results and were not retested due to insufficient sample volume. They were 
excluded from the statistical analysis. These 3 samples had low viral load with high Ct values with the comparator 
SARS-CoV-2 assay. Agena Bioscience further evaluated the performance of the MassARRAY SARS-CoV-2 Panel in 
the study described below (post-authorization study). 

Post-authorization 
study

A total of 30 positive and 30 negative specimens in VTM or UTM were tested. The 
samples were randomized, blinded, and tested with the MassARRAY SARS-CoV-2 Panel 
as described in Chapters 2-5. 

All negative samples were tested negative. Of the positive samples, 28 tested positive, 
and 2 tested Inconclusive. The Inconclusive samples were retested and all were found 
positive. Table 7.9 provides a summary of the clinical evaluation results. 

Table 7.9   Performance of the MassARRAY SARS-CoV-2 Panel Against EUA Comparator Test (post-authorization 
study

1Two (2) samples had Inconclusive results and were retested Detected. These 2 samples had low viral load with high 
Ct values with the Abbott Real Time SARS-CoV-2 assay.

Comparator Test

EUA SARS-CoV-2 Assay

Detected Not Detected Total

MassARRAY 
SARS-CoV-2 Panel

Detected 57 0 57

Not Detected 31 60 63

Inconclusive 32 0 30

Total 63 60 123

Positive Percent Agreement: 95% (57/60) 95% CI: 86.3% to 98.3%

Negative Percent Agreement: 100% (60/60) 95% CI: 94.0% to 100%

Comparator Test

EUA SARS-CoV-2 Assay

Detected Not Detected Total

MassARRAY 
SARS-CoV-2 Panel

Detected 301 0 30

Not Detected 0 30 30

Inconclusive 0 0 0

Total 30 30 60

Positive Percent Agreement: 100% (30/30) 95% CI: 94.0% to 100%

Negative Percent Agreement: 100% (30/30) 95% CI: 94.0% to 100%
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7.8  Carry-over and cross contamination study

A study was performed to assess the carry-over/cross-contamination of the MassARRAY 
SARS-CoV-2 Panel. The study was performed by testing an alternating series (i.e., 
checkboard pattern) of high positive (1x105 copies/mL of heat inactivated SARS-CoV-2 
virus, BEI Resources part number NR52286 spiked in negative NP samples in VTM) and 
negative samples (negative screened NP pooled clinical matrix in VTM by the 
MassARRAY SARS-CoV-2 Panel test) on two full 96-well PCR plates and two full 384-well 
PCR plates with the MassARRAY SARS-CoV-2 Panel as described in Chapters 2-5.

No false positive results were observed during testing of high positive samples 
alternating with negative samples, with the exception of one negative sample which was 
detected by the ORF1 assay and resulted in an inconclusive result. Results demonstrate 
that recommended sample handling and testing protocols are effective in preventing 
false positive results due to carryover or cross-contamination between samples. Table 
7.10 and Table 7.11 present a summary of the results.

Table 7.10   Summary of Carry-over/Cross Contamination Study, 96-well

1When MS2 is detected or not detected, and only one SARS-CoV-2 assay is detected, the result is 
inconclusive.

2When MS2 is not detected and zero SARS-CoV-2 assays are detected, the result is invalid.

Table 7.11   Summary of Carry-over/Cross Contamination Study, 384-well

1When MS2 is detected or not detected, and only one SARS-CoV-2 assay is detected, the result is 
inconclusive.

2When MS2 is not detected and zero SARS-CoV-2 assays are detected, the result is invalid.

Sample Group N Detected NotDetected Inconclusive1 Invalid2

Negative 94 0 (0%) 94 (100%) 0 (0%) 0 (0%)

High Positive 
(1x105 copies/mL) 94 94 (100%) 0 (0%) 0 (0%) 0 (0%)

Sample Group N Detected NotDetected Inconclusive1 Invalid2

Negative 382 0 (0%) 381 (99.7%) 1 (0.3%) 0 (0%)

High Positive 
(1x105 copies/mL) 382 382 (100%) 0 (0%) 0 (0%) 0 (0%)
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Chapter 8

Support

8.1  Customer support

Please contact your local Agena Bioscience office for customer support.

CORPORATE HEADQUARTERS & NORTH AMERICA 
Agena Bioscience, Inc.
4755 Eastgate Mall
San Diego, CA 92121 USA
Phone: 1-858-882-2800
Fax:  1-858-882-2727
Help Desk:  1-877-4-GENOME or (+1) 858-882-2800
E-mail:  helpdesk@AgenaBio.com 

EUROPE 
Agena Bioscience GmbH
Gasstrasse 18, House 5
22761, Hamburg Germany
Phone:  (+49) 40-899676-0
Fax:  (+49) 40-899676-10
Email:  support-europe@AgenaBio.com

AUSTRALIA and NEW ZEALAND
Agena Bioscience, Inc.
Ground Floor, 27 Jeays Street
Bowen Hills, QLD  4006 Australia
Phone:  (+61) 7 3088 1600
Fax:  (+61) 7 3088 1614
Email:  support-anz@AgenaBio.com

CHINA and ASIA PACIFIC
Agena Bioscience (Shanghai) Co., Ltd.
Room 1609-1613, Building A
Fenglin International Center
No. 380 Fenglin Road, Xuhui District
Shanghai 200032 PR China
Phone:  (+86) 21 6427 0566
Fax:  (+86) 21 6427 0511
Email: support-china@AgenaBio.com
Email: support-asia@AgenaBio.com

[0221]
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8.2  Related documentation

Table 8.1   Related User Documentation
Document Document #

MassARRAY System with Chip Prep Module 96 User Guide USG-CUS-069

MassARRAY System with Chip Prep Module 384 User Guide USG-CUS-097

MassARRAY Typer User Guide USG-CUS-027
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Appendix A

EUO Label for Thermal Cycler

Apply the following label to the PCR thermal cycler after qualification, as specified in 
Section 3.1, PCR thermal cycler qualification.
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Appendix B

EUO Label for MassARRAY System

The MassARRAY System is to be labeled for Emergency Use Only, using the template 
below.



ADDENDUM 

USG-CUS-148 R01 

MassARRAY® System with Chip Prep Module 96 and 

MassARRAY® System with Chip Prep Module 384 

Instrument Operation Manual Addendum 

For emergency use with the Agena Bioscience MassARRAY® SARS-CoV-2 Panel 

The MassARRAY SARS-CoV-2 Panel is authorized for use under the US Food and Drug Administration (FDA) 

Emergency Use Authorization (EUA) with the MassARRAY System with Chip Prep Module 96 and the 

MassARRAY System with Chip Prep Module 384 to qualitatively detect RNA from SARS-CoV-2 in upper 

respiratory specimens (nasopharyngeal swab, oropharyngeal swab, nasal and mid-turbinate swabs, and 

nasal and nasopharyngeal aspirate) and bronchoalveolar lavage (BAL) collected from individuals suspected 

of COVID-19 by their healthcare provider.  Refer to the MassARRAY SARS-CoV-2 Panel Instruction for Use 

(IFU-CUS-001) for additional information (https://agenabio.com/products/panel/coronavirus-sars-cov-2-

detection-panel/). 

This instrument operation manual addendum applies to the Agena Bioscience instruments listed in Table 1 

that are authorized for use with the MassARRAY SARS-CoV-2 Panel.    

Table 1: Agena Bioscience Instruments Authorized for Emergency Use Only with the MassARRAY SARS-CoV-2 Panel 

Catalog Number Product Name 

10445 MassARRAY System with Chip Prep Module, 96 Genotyping 

10447 MassARRAY System with Chip Prep Module, 384 Genotyping 

Warnings: 

• This product has not been FDA cleared or approved but has been authorized for emergency use by

FDA under an EUA for use by authorized laboratories.

• This product has been authorized only for the detection of nucleic acid from SARS-CoV-2, not for any

other viruses or pathogens.

• The emergency use of this product is only authorized for the duration of the declaration that

circumstances exist justifying the authorization of emergency use of in vitro diagnostics for

detection and/or diagnosis of COVID-19 under Section 564(b)(1) of the Federal Food, Drug, and

Cosmetic Act, 21 U.S.C. § 360bbb-3(b)(1), unless the declaration is terminated or authorization is

revoked sooner.

https://agenabio.com/products/panel/coronavirus-sars-cov-2-detection-panel/
https://agenabio.com/products/panel/coronavirus-sars-cov-2-detection-panel/
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